
Advanced Text Processor 'Dana'

"Dana" is a highly-functional text editor for Windows95 and WindowsNT.
You can edit huge and many files with great ease. Multiple document editting
capability and    many useful functions help your work.
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Features

 - MDI text editor: You can open up to 100 files to edit.
 - High-speed file open: You can open a mega bytes file in a moment!
 - Bookmark: You can mark a certain line in text and jump to each marked 

line from the list.
 - Unlimited Undo & Redo
 - Drag & Drop editting
 - Text formatting functions: Right, Left, Centered, Sort (also supports sorting 

in a box selection), etc.
 - File Maintainer: A file open dialog that supports basic file maintenance 

functions like Delete, Copy, Rename and so on. 
 - Print & Preview
 - Colored keywords: You can see user-defined keywords in different colors. 

And you can define each keywords group for specified file types.
 - High-grade find function: Many options including regular expression are 

supported. A function like GREP is also available.
 - Flexible key assignment: You can define shortcut keys that include two 

stroke keys for every function.
 - Dana Script: Programmable macro language similar to BASIC. Easy and 

flexible.
 - Long file name and UNC file name are fully supported.
 - Safety: Max 99 generations backup, auto backup and mirroring.



Getting started

For the installation, create a new directory(folder) for Dana on your hard disk.
And after you extract all the file from the ZIP archive of Dana into the 
directory, add "Dana.EXE" to a certain program group (or make a shortcut on
your desktop).
Dana itself doesn't install any files or registory keys on your system, 
therefore you don't have to worry about uninstalling. You can simply delete 
only one directory which you installed Dana.
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Open new file

When Dana is started, you can see the new file named "Untitled1". After 
writing something, you can specify the file name and save this.



Open existing file

If you want to edit a file which exists on your disk, select "File"->"Open" from
the menu.
You can see a familiar file open dialog box, then you can select or input a file 
name to open a file. If the file of which you input the name doesn't exist on 
your disk, it is opened as a new file.

By the way, Dana has a unique capability on opening files.
If the first line of the text includes a string, "@S" with a script name, the 
script is executed when the file is opened.
e.g.
/* @SMarkList */
Most popular usage of this function may be this: when you open a text and 
list all the marked lines at the same time. (MarkList.DAS, which is included in 
the Dana archive, is for this purpose.)



Open multiple files

The ordinary "Open" dialog box does not allow you to open multiple files.
Do you want to open multiple files at the same time? Okay. :-)

Open the "Tool" menu and select "File Maintainer". Then a dialog box which is
similar to the ordinary file open dialog box is brought up. This is called File 
Maintainer. The main purpose of this dialog box is opening files to edit. But it 
also supports basic file maintenance functions: Copy, Delete, Rename and so
on.
Suppose you find files which should be deleted on the file opening dialog. Do 
you want to push "Delete" key don't you? But if it is the ordinary "Open File 
Dialog", an unpleasable result may drive you nuts. ;-)

Anyway, these files in the "File Maintainer" can be selected multiplly using 
shift+cursorkey, control+left button clicking, or just dragging. You can open 
selected files pushing "Edit" button, or hitting return key.

Another tip:
If you checked the option "Bring up File Maintainer as Open" that is in the 
"Tool"->"Preference"->"Switch", you can use the "File Maintainer" even when
you call the "File"->"Open" command.



Open a file in the command line

If you want to open a particular file when you are starting Dana, specify a file
name in the command line.
It may be an unusual case to type a file name directly, but when the other 
application(like file manager) is launching Dana with the name of a 
document file, Dana is passed the command line that contains a document 
file name.

You can also specify the line number and the column in the command line.

Usage:
        Dana <Filename>+<Line>:<Col>
e.g
        Dana test.txt+100:10



Command line options

You can specify the following command line option for Dana.

/P Print preview page for a following file is shown after starting Dana.
/H Opens following files in HTML mode regardless the extention.

(If you are using Dana for NetScape's View Source, specify this 
option after the "Dana.EXE" command in the NetScape's 
configuration.

/A Run specified script file right after starting Dana.
(e.g. Dana /AHTMLMode.DAX)

/W Opens specified workspace file. (.prf extention can be omitted)



Initial settings

Generally, Dana may work happily without changing any setup parameter. 
But it is better to specify a couple of parameters about directories.
If you want further information about the other setting parameters, see 
Preferences.

Dana refers three directories: home directory, back up directory, mirroring 
directory.

The home directory is, as default, the same as the directory that contains 
Dana.EXE. You can change this directory to another one by specifying 
DANAHOME environment variable. The home directory has to contain the 
system files of Dana: Dana.DAT, Dana.INI, Dana.KWD, Dana.KEY, *.DAS,    etc.
If you are using WindowsNT, you can set environment variables in "System" 
of Control Panel. But if you are using Windows95, you may have to set 
environment variables in the AUTOEXEC.BAT file as follows.

SET DANAHOME=C:\DANAHOME

Back up directory is specified in "Tool"->"Preferences"->"Files".
It is, as default, specified as "TMP", and "Use Environment Variable" is 
checked. It means    the "TMP" environment variable which indicates 
particular directory like as follows is specified as the backup directory.

SET TMP=C:\TEMP

Dana creates back up files in this directory. If "Use Environment Variable" is 
not checked, you have to specify the *directory name* as the back up 
directory. if the back up directory is not specified, Dana creates back up files 
in the directory where the original file is located.
If "Generations" is specified as 0, Dana doesn't create any backup file.

If you specified the mirroring directory, you can save a copy of the original 
file to the particular directory. It is not specified as default. The way to 
specifify the mirroring directory is the same as the back up directory.
Note that the mirroring directory MUST NOT indicate the same directory as 
the back up directory.



Main menu of Dana

Most of functions of Dana can be accessed from the menu.
The menu is divided into 6 categories as follows.

File
Edit
Find
Tool
Window
Help



File

It basically contains the file handling functions.

New
Open
Close
Save and Close
Save
Save All
Save As
Print
Print Preview
Open Another Dana
Select Folder and Open
Save Workspace and Exit
Save All and Exit
Exit



Open a new "Untitled" file to edit.
The file name should be fixed when it is being saved.



Open an existing file on your disk.
If the specified file is not exist, it is opened as a new file. If you want to edit a
new file and specify the name of it to make the settings for each file type 
effective, use this function to open a new file.



Close the current work file.
If the file has been changed, Dana prompts you to save this or not.



Close the current work file.
If the file has been changed, Dana saves the file before closing it.



Save the current work file.
If the file is an "Untitled" file or the file does not exist on your disk, Dana 
prompts you to specify the name of the file.



Save all the work files that havs been changed.



Save the current work file as another file.



Print the current work file.



Display a print preview image of the current work file.



Run another instance of Dana and open file.
It enable you to use Dana like as SDI application and, of course, you can 
open multiple MDI sessions.



Open file in the registered folder.



Save all the work files and the workspace and exit editor.
At the next time Dana start, all the working status is recovered to resume the
work.



Save all the work file and exit editor.



Exit the editor.
If there are files that have been changed, Dana prompts if you want to save 
each of them or not.



Edit

It basically contains edit commands. 

Undo
Redo
Repeat
Step Undo and Redo
Cut
Copy
Paste
Paste from History
Box Select Begin
Box Paste
Select All
Convert
Paragraph
Copy to File
Append to File
Paste from File



Undo the previous editting on the current work file.
You can give a limitation on the buffer size for undo by specifying "Tool"-
>"Preferences"->"Values"->"Undo Buffer Size Limit"



Redo the editting that has been undone previously.



Repeat previous input operation.



Undo and Redo by steps you specified.
For example, inputting a character can be undone one by one. You can 
specify number of characters you want to be undone.



Cut the selection and copy to the clipboard.



Copy the selection to the clipboard.



Paste text in the clipboard to the caret position.



Paste the text data that has been cut or copied to the clipboard before by 
selecting from the history.



Begin the box-mode selection.
You can cut or copy the selection using ordinary Cut, Copy command.



Paste the text data that has been cut or copied as a box.



Select the entire text.



Convert the selection: Upper/Lower case, Tab/Space.



Paragraph
Execute following paragraph editting command.
The one line is the one *logical* line. (The end of line is a return code.)

    Left Move the selected lines to the leftside of the screen.
    Right Move the selected lines to the rightside of the screen.
    Centered Move the selected lines to the center of the screen.
    Indent Add one indent level to the selected lines.
    UnIndent Let the selected lines back by one indent level.
    Append Add specified string to the top/end of the strings that is 

selected.
    Sort Sorts the selected lines.



Write the selection to a specified file.



Write the selection at the end of a specified file.



Paste a specified file to the caret position.



Find

It basically contains the commands for finding and jumping.

Find Forward
Find Backward
Replace
Find in Files
Tag Jump
Back to Tag File
Jump To
Previous Position
Top of File
End of File
Toggle Bookmark
Bookmark on Title Line
List Bookmarks
Clear Bookmarks



Search a specified string forward direction.
Find Dialog



Search a specified string backward direction.
Find Dialog



Replace each found string into a specified string.
Replace Dialog



Find a specified string in files and Paste the information about it at the output
screen of Dana like as follows.

FILENAME.TXT(10):
FILENAME.TXT(12):
FILENAME.TXT(15):
FILENAME.TXT(20):

Find in Files Dialog



Open a file and move caret to an applicable position according to the 
retrieved tag information from the caret position.



Activate the tag file window from which the tag information has been 
retrieved.



Move caret to the position which is specified by line number.



Move caret to the previous position after Jump or Find command.



Move caret to the top of the file.



Move caret to the end of the file.



Toggle bookmark on the current line or the selected lines.



Set bookmark on each line which begins with the "Title Character".



List up all the marked lines.
Bookmark list dialog



Clear all the bookmarks in the current file or the selection.



Tool

User preferences settings, executing other applications, executing scripts 
and so on.
Preferences
Shell
Program Launcher
Record Key Sequences
Run Key Sequences
Script Jukebox
Load Workspace
Save Workspace
Compare
File Explorer



To customize Dana, change these parameters.

Values
Switch
Files
Appearance
Font/Color
Layout
ShortCut
Menu
Addin
Keywords
Advanced



Execute the other application.



Execute the other application from the icon launcher to which you can 
register preferable applications.



Start/Stop the recording key sequences.



Playback recorded key sequences.



Register, Execute and Edit "Dana Script" scripts. 

If you want to run a script from the menu or the shortcut keys, set Tool-
>Preferences->Addin.    16 permanent scripts can be assigned there. 
You can register 26(A-Z) * 10 scripts to this "Juke box".

Script Jukebox dialogbox



Load a workspace file previously saved.



Save current workspace as a project file.



Compare the current file and the other file. Different lines are marked after 
the comparison.



Bring up the file open dialog which has basic file maintenance functions: 
copy, delete, rename, and so on.
Details



Window

It basically contains the window arrangement functions.

Cascade
Tile Horizontally
Tile Two Windows
New Window
Split current window
Arrange Icons
Select Edit Window



Cascade all the MDI child windows.



Tile all the MDI child windows horizontally.



Tile the two windows: current window and previous current window.
This function toggles tiling mode Horizontal->Vertical->Maximized.



Open a new window that shares the same document with the current 
window.



Split the current window in two.



Arrange the minimized MDI child windows.



Change the current window to the other window selecting from the list.



Help

It basically contains the help command. User defined helps can be seen here.

Contents
About Dana



The contents of the help of Dana.



Display information about the current version, the copyright and the user 
licence.



Left

Move selected lines to the left.



Right

Move selected lines to the right.



Centered

Arrange each selected line to the center of the columns.



Sort

Sort the selected lines.

Sort dialog



UnIndent

UnIndent the selected lines.



Indent

Indent the selected lines.



Add String

Add a string to the top or the end of each selected line.



About Dana

Displays information on the version, the copyright and the user licence.



Files property page

You can configure the following parameters in the "Files" property page.

Save Mode
    Normal: No conversion on saving.
    Tab to Space: Convert tab codes into whitespaces.
    Space to Tab: Convert whitespaces into tab codes as long as 

possible.

Text Type
    DOS text: Save end of each line as CRLF.
    UNIX text: Save end of each line as LF only.

Save Mark Information: Save bookmark information as a mark information 
file.

Add ^Z code: Add EOF code (0x1a) to the end of the file on 
saving. This option is just for the compatibility of the
old fashioned DOS application.

Delete EOL space: Eliminate tab and whitespace which is found at the 
end of each line on saving.

Backup
    Generations: Specify the number of backup generations.
    Backup Directory: Specify the directory for backup files.
    Use Environment Variable: If checked, you have to specify a environment 

variable instead of a backup directory.
    Mirroring: You can create mirror backups on saving.
    Mirroring Directory: Specify a directory for mirroring.
    Use Environment Variable: If checked, you have to specify a environment 

variable instead of a mirroring directory.

    Auto backup wait: You can specify the second to wait auto backup. 
When specified seconds has passed since the last 
time you typed the keyboard, current work files are 
automatically saved as temporary files. If Dana is 
terminated abnormally, the lost data can be 
recovered when Dana is restarted.
If you specified it zero, Dana never creates auto 
backup file.



Find dialog

Find String: A string you want to search. '\'character is the 
escape character.

From Beginning of Text: Start searching from the top of the current file.
In All Windows: Search in all files currently opened.
Mark Found Line: Set bookmark on a line which includes the matched 

strings.
Match Whole Word: Match a string whose before and after character is a

whitespace or one of the delimitering characters.
Match Top of Line: Match a string which is at the top of the line. 
Ignore Case: Search with no upper/lower case sensitivity.
Regular Expression: Use regular expression for the find string.

Mark All: Search in a whole text and mark all the found lines 
at once.

Save Option: Save this condition as the default setting.



Replace dialog

Find String: A String you want to find. '\'character is the escape 
character.

Replace String: A String you want to replace.

From Beginning of Text: Start searching from the top of the current file.
In All Windows: Search in all files currently opened.
Mark Replaced Line: Set bookmark on the line which includes the 

replaced strings.
Match Whole Word: Match a string whose before and after character is a

whitespace or one of the delimitering characters.
Match Top of Line: Match a string which is at the top of the line. 
Ignore Case: Search with no upper/lower case sensitivity.
Regular Expression: Useregular expression for the find string.

Replace All: Find and Replace in a whole text at once.
Save Option: Save this condition as the default setting.



Jump To dialog

Line No: Specify the line number to which you want to jump.

As Shown/Logical: Specifiy the line number mode. "Logical" means that
the line number is the same as the count of return 
codes.



Mark Listing dialog

List up all the bookmarked lines in the current file. Sometimes you see "+" 
mark beside the book icon, which means following indented marked lines are
hidden. You can see those foled lines by double clicking the book icon.
You can go to any marked position by hitting return key on one of the lines in 
the list. Then the list is closed and edit window is activated.
If you hit the space key or double click, you can see around the marked line 
on the editor screen. Shift+Up/Down cursor key lets the edit window scroll.

When the list lose its own input focus, it is automatically closed. When you 
open this window again, it recovers previous status as long as possible.

Target File: You can select the target file of bookmark listing.
<<: Hide all the indented marked lines.
>>: Show all the marked lines.



Clipboard History dialog

When you select one item in the above list, this data is copied to the below 
text box. You could edit this data if you want.

Paste: Copy the selected data to the clipboard and paste 
into the caret position.

Copy: Copy the selected data to the clipboard.



Replace? dialog

Yes: Do replace.
No: Do not replace and search next.
Replace All: Replace all the found strings right away.
Cancel: Cancel replacing.



ShortCut property page

You can configure the following parameters in "ShortCut" property page.

Functions: You can see all the command names of Dana in this list. And 
you can select a function whose key assign should be 
changed.

Key Assign: You can see currently assigned short cut key for the selected
function. It can be deleted by "Delete" button.

Key To Add: You can specify a key stroke here. Set input focus on this 
text box and hit *actual* key stroke. The particular key 
strokes: Tab, CR and ESC, which cannot be input directly in 
the dialog box, can be input by pushing the button below the
text box.(F1 key cannot be specified here. It should be 
assigned to Help command.)

You can assign this key stroke to a function pushing "Add" button. Note that 
max 2 shortcut key can be assigned for one function.

Two Stroke: You can specify the prefixes of the "two stroke" key 
assignment from A to Z. Two stroke key is not popular for 
Windows applications. But if you are get used to use the 
DOS text editor which has "Word Star" like key assignment 
or you are an EMACS nuts and can't live without C-x C-* key 
assignment, you can use this weird (for Windows user <g>) 
key stroke. For example, description "K" means that Ctrl+K 
is used as the prefix of the two stroke keys.

Load Load key settings previously saved. The loaded key 
definition is used as default.

Save Save current key settings as a certain key definition file.



Switch property page

You can configure the following parameters in "Switch" property page.

Insert Mode: Set default edit mode to insert/overwrite mode.

Word Wrap Mode: A return code is automatically inserted around 
the column position which is configured as 
"Word Wrap Point" in "Values" property page.

Use Shiftkey to Select Text: You can use the shift + cursor key to select 
string. If not, you can assign the shift + cursor 
key to a particular function you like.

C language Mode: The indent level of "}" corresponding "{" is 
automatically adjusted. And when you input a 
return code after the character "{" or ":", the 
top of the next line is automatically indented.

Fix Caret on Middle of Screen:When the caret position is moved by finding or 
jumping command, fix the caret position at the 
middle of the screen.

Select Found Word: Select the word which is found. If you always 
want to specify the end of the selection using 
finding command, do not check this option.

Permit Caret After EOL: When the caret is moved up/down and caret is 
located at the after the end of the line, let the 
caret stay at the same column position. It 
doesn't mean Free Caret Mode because even if 
the caret is seen after the EOL, the logical 
position of the caret is at the EOL.

Free Caret: You can move the caret at any position you like, 
even after the EOL, and input characters exactly
there.

Padding by Tab: When you input a certain character after the 
EOL, from the EOL to the caret position is 
normally filled by whitespaces(20h). If this 
option is checked, it is filled by tab(09h) codes 
instead.

Clear Undo Buffer When Saved: When you save a text, the undo buffers 
for it are cleared.



Initial Window is Maximized: When Dana is started, the initial "Untitled" 
window is maximized in the MDI frame.

Bring up File Maintainer as 'Open': When you selected the ordinary 'Open' 
command, Dana bring up the "File Maintainer" 
to open files.

Save Window Position on Exit: The next time Dana is started, the size 
and the position of the application window is 
restored as the last time Dana is terminated.

Fix Window Position If checked, Dana always starts up at the same 
position and size. To save the current position 
and size as the default, push "Save Current" 
button.



Values property page

You can configure the following parameters in "Values" property page.

For Each File Type
    File Type: Select the target file type you want to configure.

    Extention: Specify the extention for the selected file type.
    Comment: A brief description about the selected file type.

    Tab Columns: Specify the number of tab columns.
    Columns: Specify the maximum columns.

    Auto Indent: Set auto indent mode for the selected file type.
    Soft Tab: When tab key is pressed, whitespaces are input 

instead of a tab code.

Common
    Word Wrap Point: When word wrap mode is on, Dana decides the 

returning position according this value.
    Undo Buffer Size Limit: To save memory consumption, you can give a 

limitation on the size of the undo buffer.



Font/Color property page

You can configure the following parameters in "Font/Color" property page.

Font
    Screen/Print: Select the target which you want to change the font.
    Font Name: Select the font name from the combo box below. You

can select a fixed pitch font only.
    Size: Specify the *pixel* font size(not points). If TrueType 

font is selected, you can specify the font size 
inputting a value in the text box directly.

Color
    Object: Select the target you want to change the color.
    Color: Select the color you want to assign.
    Custom: You can create the special color for each target. (You

can create any color in High-color mode or higher. 
But in 256 color mode or lower, you can't create the
color exactly you expected.)



Find in Files dialog

Find String: A string you want to find.

File Type: Specify the mask pattern of files in which you want 
to find a string.

Directory: Select the current directory by selecting in the list 
box or inputting a directory name in the text box.

Match Whole Word: Match a string whose before and after character is a
whitespace or one of the delimitering characters.

Match Top of Line: Match a string which is at the top of the line. 
Ignore Case: Search with no upper/lower case sensitivity.
Regular Expression: Useregular expression for searching.

Search Sub Directories: The file in sub directories can be a target of 
searching.

Output Full Path: Output finding results with full path names.



Appearance property page

You can configure the following parameters in "Appearance" property page.

Line Number: Display line number at the left of the edit window.
    Logical/As Shown: Set the line number mode.
Function Keys: Display the function keys at the bottom of the main 

window.
    By 4/By 5: The way of displaying function keys. You should 

select "By 4" if you are using a standard PC 
keyboard.

Ruler: Display a ruler at the top of the client window.
Tab: Display tab characters to be recognizable.
CRLF: Display return characters to be recognizable.
End of File: Display a end of the file to be recognizable.
Vertical Scroll: Display a vertical scroll bar.
Horz Scroll: Display a horizontal scroll bar.
Line Pointer: Display a line pointer leftside of the client window.
Box Caret: Display a DOS like box type caret.
Under Line: Display an under line at the focused line.
Edit Mark: Display edit marks at each editted line.
Status bar: Display a status bar at the bottom of the main 

window.

Line Spacing: Specify the pixels of extra spaces between lines.

Tool Bar: Select the target tool bar you want to configure in 
the combo box. You can select one of five and 
specify if it can be seen or not. You can see buttons 
of each tool bar in the list box. And clicking it, you 
can specify if each button of the toolbar can be seen
or not.

Large Button: Make all the buttons of the toolbars little bigger.
Reset Position: Locate all the tool bars at the default position.



Keywords property page

You can configure the following parameters in "Keywords" property page.

Colored: Keywords can be seen in a specified color.
Bold: Keywords can be seen in a bold font.

Registration
    Group: Select the keywords group from 0 to F (16 group).
    Color: Specify the color for the selected keywords group.
    Extention: Specify the externtion for the selected keywords 

group.
    Add: Add new keyword.
    Delete: Delete selected keyword.
    Keyword to Add: Input a string as a keyword to add.

Title Character: Specify title characters which are used by the title 
marking command.

Delimiters: Specify the delimitering character. These are refered
by many functions: moving caret by word, matching
whole word in find command and so on.



Select Window dialog

Select the window to edit.
If you select "Open New File", you can open a new file here.

The blue icon which is seen at the left of the item represents the current 
file(focused window), grey icon means the sub-current file(previously focused
window). These two window is tiled when you call the "Tile Two Windows" 
command.



Step Undo/Redo dialog

Steps: Specify the number of steps you want to undo or 
redo.

Undo: undo by the specified steps.
Redo: redo by the specified steps.



Execute Program dialog

Command Line: Input the command line you want to execute.
Minimized: Execute program with minimized window.
Get Console Output: Get the console output into the editor. You also can 

specify that output strings will be inserted into the 
"Output" screen or the caret position of the current 
editting window.

via Command Shell: Execute via the command shell of your operating 
system: usually it should be COMMAND.COM or 
CMD.EXE. If you are running a DOS program, it is 
better to check this option sometimes. Basically it is
needed for internal commands like "DIR".

Directory: Change the current directory.
Browse: Search the program file on your disk.



File Explorer dialog

File Maintainer is the open file dialog which supports the basic file 
maintenance functions.

File Name: You can specify a file name to open or a file pattern 
to select. You can specify multi files delimitering by 
";"(semicolon) as well.
In some case, you don't have to specify the file 
extention, then the extention which is defined as 
the user file type: C programs, User defined, is 
automatically added and the completed file name 
which is found on your disk is opened.

Permit Long File Name: Switch to the displaying long file names mode. In 
this mode, only the file size information is displayed.

Usual: You can register directories usually you use. 
Registering the UNC directory name which begins \\ 
is also OK.

Function button File maintenance commands are assigned. Each 
button corresponds the function keys except F10. (It
is reserved by Windows)

Help: Display this help.
Exec: Execute an application or a document which is 

related to an application.
Copy: Copy selected files to a specified directory. You can 

call this command by Insert key.
Delete: Delete selected files. You can call this command by 

Delete key.
Name: Rename a selected file.
Sort: Change the file sorting mode.
View: View a selected file.
Archive: Archive the selected files into ZIP or LZH. (You need 

PKZIP.EXE, LHA.EXE or UNLHA32.DLL)
Extract: Extract a selected archive file. (You need 

PKUNZIP.EXE, LHA.EXE or UNLHA32.DLL)



Program Louncher dialog

A-Z: Execute the program which is assigned to this 
button.

Reg.: If checked, you can register the program to the 
selected button.

ChgDir: Change the current directory.



Register Program dialog

Position: Select the button you want to register a program 
from A to Z.

Command Line: Input the command line of the program. And it may 
include following macro symbols in it.
%F The file name of the current work file.
%N The file name without extention of the current 
work file.
%P The full path name of the current work file.
%D The directory name of the current work file.
%E{Env} A string which is indicated by a 
environment string described in {}.
%T The file name of the temporary file which 
contains the current selection.
%I A string which is input by user when it is 
executed.
%% '%'itself

Start In: Specify the initial directory.
Comment: A brief description for this program.

Minimized: Execute program with minimized window.
via Command Shell: Execute via the command shell of your operating 

system: usually it may be COMMAND.COM or 
CMD.EXE. If you want to run a DOS based program, 
it's better to check this option. If you are executing 
the internal commands like "DIR", you must check 
this option.

Get Console Output: Get the console output into the editor. You can also 
specify that output strings will be inserted into the 
"Output" screen or the caret position of the current 
editting window.

Save Current File: Save current work file before executing.
Save All Files: Save all the files currently opened and changed 

before executing.



Menu property page

You can configure the following parameters in "Menu" property page.

Select the target to be configured in the combo box.
You can define user menu (up to five) and user help (up to ten).

User Defined Menu
    Insert: Add an empty item to the current menu.
    Delete: Delete the item which is selected.

    Menu Item: Describe a menu item string. If you want a nemonic 
key, add "&" before the character to be a nemonic 
key.

    Command: Select a Dana's command which you want to add to 
the menu.

    Shortcut Key: Specify a shortcut key to execute this command. 
You can assign max two key strokes in "ShortCut" 
property page.

User Defined Help
    Menu Item: Describe a menu item string to be added to the 

"Help" menu.
    File Name: Specify the file name of the help file. If it doesn't 

contain a path description, it is assumed that the 
help file is in the same directory in which Dana.EXE 
exists.

    File Type for Keyword Searching: When you are editting a file whose file 
type is specified here, F1 key can be used to open a 
keyword help for the word on which the caret is 
located.



Convert dialog

Case
    No Conversion: No operation.
    UPPER ALL: All the characters in the selection to be upper case.
    lower all: All the characters in the selection to be lower case.
    Upper top of line: A character at the top of the line to be upper case.
    Upper Top Of Word: A character at the top of the word to be upper case.

Tab and Space
    No Conversion: No operation.
    Tab to Space: All the tab characters in the selection to be 

whitespaces regarding tab columns.
    Space to Tab: All the whitespaces in the selection to be tab 

characters regarding tab columns as long as 
possible.



Compare dialog

Current File: It shows the file name of the current work file.
Target File: Select the file to be compared to the current file in 

the combo box.

Range of Scanning Next Start Point:This parameter specifies the range of 
seeking the next matched line in both of the files 
when the different line is found. If your file to be 
compared is drastically changed from the original 
file, you should specify this parameter bigger.

Lines to Decide as Matched: This parameter specifies how many lines which
are matched are assumed the next starting point of 
scanning. If your file has numbers of same text 
blocks, you should specify this parameter bigger.



Dummy
It's dummy. Thank you. ;-)



Script JukeBox dialog

You can run, register and edit the script files in this dialog box which can 
contain up to 260 ((A to Z) * 10 group) scripts.
Script files should be in the directory where Dana.EXE is or the directory 
which "DANAHOME" environment variable indicates.

A-Z: Run, register or edit the script in this button.
Browse: Run the script file which is not registered.

Run/Register/Edit: Decide the action for A-Z button.



Addin property page

You can configure the following parameters in "Addin" property page.

Command Script
    You can register 16 permanent script of Dana. A script which is registered 
as a permanent script can be added to the "Tool" menu and be assigned to 
shortcut keys.

Script Name: Specify the script name. You don't have to specify 
the ".DAS" extention. You can add ".DAX" extention 
optionally. It means Dana compiles this script only 
when the source file (*.DAS) is modified or the 
Dana's version is updated.

Register as the Item of Tool Menu: Add this command to "Tool" menu.
Menu Item: Specify the menu item string for "Tool" menu.
Shortcut Key: Specify the shortcut key for this command. Hit an 

*actual* key stroke on the text box. (Tab, CR or ESC 
can be input by pushing the button)

Residential Script

Scirpt Name: Specify the default script which is to be loaded and 
executed when Dana is brought up. You can specify 
".DAX" extention.

(List box): Residential scripts which is currently alive are listed.
You can release a selected script by hitting "Delete" 
key.



Register Script dialog

Scirpt Name: Input name of a script to be registered. you don't 
have to specify the ".DAS" extention.

You can add ".DAX" extention optionally. It means Dana compiles this script 
only when the source file (*.DAS) is modified or the 
Dana's version is updated. Script files should be in 
the directory in which Dana.EXE exists or the 
directory "DANAHOME" environment variable 
indicates.

Comment: Input a brief description about this script.



Layout property page

You can configure the following parameters in "Layout" property page.

Header: Specify a format string to be used as the page 
header.

Footer: Specify a format string to be used as the page 
footer.

You can use the following macro symbols for a format string.
&p The page number.
&f The full path name of the file.
&n The file name.
&w The title of the window.
&d The current date.
&t The current time.
&& "&"itself.

Packed print: Print two pages in one sheet.
Margin: Specify the top, bottom, left and right margin in 

milimeter.



Escape characters

\t Tab
\n Line feed
\b Bell
\f Form feed
\e Escape
\r Carriage return
\0 Null
\xXX Control code represented by XX (0x01 to 0x1f)
\\ '\'itself



Regular expression

Dana's "Regular Expression" is quite primitive, but usable enough.
The following expressions are supported.

^ Match the top of a line.
$ Match the end of a line.
X|Y Match X or YiX,Y is a regular expression)
[A-Z] Match a character between A and Z. (A, Z is a certain character)
[^A-Z] Match a character which is not included between A and Z.
[ABC] Match a character one of the characters "ABC". (A,B,C is a certain 
character)
[^ABC] Match a character not one of the characters "ABC".
. Match any one character.
X* Match zero or more repeat of X. (X is a regular expression)
X+ Match one or more repeat of X.
X? Match X or empty string.

A regular expression between () has higher priority of operation.



Edit Text

Dana has many basic functions for editting texts: Cut, Copy, Paste and so on.
Plus, very unique and useful functions can help your editting.

Drag & Drop Edit
Word Wrap
Conversion
Paragraph
Use external filter program
HTML capabilities



Drag & Drop Edit

Dana supports Drag and Drop editting.
After you selected a text block, click the left mouse button on the selection. 
You can see the different figure of the mouse cursor. It indicates that 
dragging is started. 
Next, keep pushing the left mouse button and move the cursor to a position 
where you want to paste it. You can "drop" it there releasing the left mouse 
button. If you are pushing Ctrl key then, the dropping data is copied, if not, it 
is moved (the source is deleted).
Dragging out of the screen with pushing Shift key lets the current window 
scroll.



Word Wrap

If you are writing a uploading text for a BBS or E-mail, you should input a 
return code for each end of line at about 70 to 80 columns position, because 
70 to 80 columns are suitable for any kinds of terminal.
Dana's word wrap mode supports entering a return code    automatically 
around at a specified columns position. you can write a text without 
bothering to enter a return code for each line.
But If you are editting existing text, you have to trim each line manually. 
In this case, "WordWrap.DAS" script which is included in Dana package is 
useful. Select the text which you want to reform and run it. (It can be seen in 
"Tool" menu as default.)



Conversion

You can convert the selection into the other kind of characters.

For example, if you are editting a text and it includes a part of program 
source code which contains tab codes. Some BBS host doesn't permit that 
uploaded text to include tab codes. You can use the Tab-Space conversion 
command to get rid of it.

The other case, IF SOMEHOW YOU HAVE TO READ HUNDREDS LINES OF 
CAPITAL TEXT. YOU CAN USE THE CASE CONVersion command to make it 
easy to read.

You can go back to the not-converted text by undo command, so don't warry 
to use these function.

Convert dialog



Paragraph

You can use reformatting commands so that you make your text looks better.

Left, Right and Centered are the most popular formatting commands. They 
are simple but useful. These commands assume that the right side of the 
text is "Word Wrap Point" which is defined in "Value" property page if word 
wrap mode is on.
If word wrap mode is off, "Columns" value is used as the right side of the 
text.

Indent and UnIndent are also the useful when you are editting program 
sources.
This command can also be called by pushing Tab key when you are selecting 
text. (This usage may be more convenient. :-) )

Add String is used when you want to add a certain string at each top or end 
of lines.
For example:
- When you paste text copied from the other file for a sitation,
      and you want to add "> " at each top of line. 
- When you are editting a HTML text and you want to add "<BR>"
      at each end of line.

Sort is sometimes useful.
If you are writing C programs and you've already written many prototypes in 
chaotic order. You cannot find a particular prototype immediately, so you 
want to sort them in alphabetical order. By hand? It may be very good for 
killing time. But if you are short on time, the sorting command of Dana helps 
you. :-)
When you are selecting text with box mode, text only in the box is sorted.



Use external filter program

Dana can pass the current selection to other applications for its input file. 
Using this capability, you can use a DOS based robust filter program just like 
as one of the functions of Dana.

The way to do is as follows.
1) Bring up the "Program Louncher" in "Tool" menu.
2) Check "Register" check box.
3) Push a certain button you want to assign a program.
4) Write like "Filter.EXE %T" for "Command Line".
5) Check "Minimized" and "via Command Shell" check box.

If Filter.EXE writes its output to the same file for input, that's all.
But the most kinds of filter programs write their output to "stdout". If so, 
check "Get Console Output" check box and select "Cursor Position" radio 
button.

Register programs



HTML capabilities

When you read files whose extentions are "HTML" or "HTM", inside of HTML 
tag is displayed in the different color. And colored keywords are effective only
in HTML tags. (between "<" and ">")

I have added popular HTML tags as the default keywords of Dana. If you 
would like more tags for colored keywords, add them at "Keywords" page in 
"Preferences".

Ctrl+] command (brace matching) enables to match HTML tags. For 
example, if you locate the caret on "BODY" and hit Ctrl+], then the caret is 
moved to the corresponding "/BODY".

If you are using Dana for NetScape's View Source, specify "/H" option after 
the "Dana.EXE" command in the NetScape's configuration because NetScape
pass the HTML source as "*.txt" file.



Use bookmark

One of the most powerful functions of Dana is the bookmark capability.
You can mark any line in a text: A line including a string which is found by 
Find or Replace function, A line including a title character.
You can see all the marked lines in the bookmark list and those mark 
information can be saved on your disk.

You can use Dana like as an outline processor with this bookmark capability.

Bookmark List
Mark lines you want
Mark a found line
Mark title lines
List bookmarks
Erase bookmarks
Mark when open a file



Mark lines you want

Put the caret on a certain line and select "Find"->"Toggle Bookmark" in menu
or pushing the tool button.
This function toggles on/off a bookmark of the current line.
If you want to mark multiple lines, you can call this function after selecting 
the text.



Mark a found line

If you want to add a bookmark on a line in which a particular string is found, 
check "Mark Found Line" in "Find" dialog box. Or if you push "Mark All" button
instead of pushing OK button, all the found lines are marked immediately.
Of course, you can also use this capability in "Replace" dialog.



Mark title lines

Sometimes you may want to mark lines which begins with a particular 
character.
Of course, you can do this by "Find" function, but Dana supports this function
permanently as "Bookmark on Title Line" command.
Once you have specified "Title Characters" in "Keyword" property page, you 
can mark all the lines which begins with those "title" characters.



List bookmarks

To list all the bookmarked lines, select "Find"->"List Bookmarks" command.

This list initially hides indented marked lines. Pushing ">>" button make all 
the marked lines visible, and pushing "<<" button hides indented lines 
again.
The book-figured icon with "+" mark means indented lines are hidden after 
this line. Double-clicking this icon make following invisible lines visible, and 
vice versa.

If you select a certain line in the list and hit return key, you can go to the 
actual position in the editor. Then the list is closed.
If you hit space bar or double click the item, you can go to there, but the list 
is still active.
The list dialog disappeares when it loses the focus.



Erase bookmarks

You can erase all the bookmark in the current text by "Find"->"Clear 
Bookmarks". If you are selecting text, bookmarks in the selection are only 
erased.



Mark when open a file

To add bookmark on particular lines when you open a file, there are two 
ways.

One is to edit the Dana's initial script.

See this part of Dana.DAS (Dana.DAS is in the directory Dana.EXE exists.)

'///////////////////////////////
' After open file
Proc OnAfterOpen()

Command("TitleMark")
Dim L%, M%
L% = GetTopLine()
M% = GetNextMark(L%)
If (M%) Then

Command("MarkList")
End If

End Proc

It means that when a file is opened, the "TitleMark" command is executed 
and if at least one marked line is found, bring up the bookmark list dialog.
It is just one of examples.
If you want, you can use regular expression to find lines instead of title mark 
command.

The other way is to use the Dana's "Open and Execute" capability. When a 
file is opened and the word begins with "@S" is found at the top of the text, 
Dana assume that the following word after "@S" is a name of a script and 
execute it.
For example, you can describe like this in your C source code.

/* @SFuncList */

Dana runs "FuncList" script when this source is opened.
Usually, Dana searches a script in the directory Dana.EXE exists. But in this 
case, Dana search it in the directory the opened text file exists at first.
So, you can distribute text files with some script files for the other users of 
Dana.

For more information on Dana Script, see DanaScr.HLP



Advanced property page

You can configure the following parameters in "Advanced" property page.

Scroll
    Mode: Select the way of scrolling. Scrolling speed of each mode is 

depends on the performance of your video card and the 
driver software. Generally, "Monochrome1" is the fastest for 
most of machines.

    Accelaration Specify if you want to accelarate the scroll after certain 
times key repeating.

        Smooth: If you have a fast video card, select this.
        Skip: If your video card is not fast enough, select this.
    Key Repeats Before: Specify the times of key repeating before the 

accelaration.

Startup
    Permit Multi Instances: If specified, you can run multi instances of 

Dana.
    Most Recently Used: Specify the numbers of history of file names which 

can be seen in "File" menu. Up to sixteen. If your machines 
display resolution is VGA, it's better not to specify greater 
than four.



User Registration

Payment Method:
Select the way of payment you used. You can only select Kagi 
Shareware currently.

Your Name:
Input your or your company's name.

Registration Code:
See a E-mail reply which you receive after the payment.

E-mailF
Input your E-mail address. (name@domainname)

Be sure that there is no mistake, then push "OK" button. These information 
cannot be changed after the registration basically. If you want to change 
them, please contact me.

About the registration



About the Registration

Dana is a shareware: distribution and trial are free of charge. If you want to 
continue to use this software, please pay for it. Trial period is up to 30 days.
Followings are the procedure of the registration.

What's the benefit to register
Check before the registration
Price
How to pay



What's the benefit to register

- You will not see the annoying "Unregistered" dialog box any more.

- You will be notified the major version up of Dana.

- You will receive the information on the other products, both free
    softwares and sharewares, of RIM-Arts in the future.



Check before the registration

- You MUST have an E-mail address.

Without an E-mail address, you can't receive a registration pass code.
"E-mail address" here means one which can receive Internet mail.
If you are, for example, a member of America Online, or whatever network 
service which supports Internet mail, your E-mail address should be

          YOURID@aol.com (America Online)
          YOURID@compuserve.com (CompuServe)
          ...

- You MUST have one of the payment methods which are supported by Kagi 
Shareware.

Credit Card: Visa, Mastercard, American Express.
Check or Money Order
Cash (It is not a good idea because of the security reason and sending 
cash is prohibited in some country's law.)
First Virtual: see http://www.fv.com
Invoice



Price

 30 US$ for a personal licence.
600 US$ for a site licence. 

(A site licence is a free licence which covers a single organization for an 
area of up to one hundred miles (160 km) )



How to pay

 - Run REGISTER.EXE. (REGISTER.EXE is included in the Dana package.)

 - Fill out the information such as your name, E-mail address, number of 
licences you are purchasing, and payment method.
For more details, see REGISTER.HLP.

 - Send the output of REGISTER.EXE to Kagi Shareware 
(shareware@kagi.com) via E-mail or postal mail. Please do NOT send it to 
me directly.

 - You will receive a confirmation of the payment and a registration pass code
via E-mail. Generally, it takes less than a week to receive it. Long weekend,
heavy network traffic, etc., may cause a several days delay however. If you
do not receive a reply in two weeks, please contact me. (carty@kagi.com)

 - Run Dana and select "User Registration" from "Help" menu.

 - Select the "Kagi Shareware" as "Payment Method". Kagi shareware is the 
only method you can select currently.

 - Fill out the information: your name, registration pass code and E-mail 
address, and push "OK".

If you have any problem with the registration procedure, feel free to contact 
me. (carty@kagi.com)



Sort
Sort the selection by ascendant or descendant order.

You can select the following option.

Case Insensitive: Comparing string ignoring upper/lower case. 'A' and 'a' are 
treated as the same.

Sort Lines: This option can be selected when you are selecting text in 
the box mode. If this option is not checked, only inside of the
block is sorted. If checked, the box selection is treated as 
sort keys and entire lines are sorted.

    e.g.
1000 Jane
1001 Michael
1002 Hayley
1003 Peter
1004 Billy
1005 Amanda

If you select the names in box mode, the result of sorting should be the 
following.
1005 Amanda
1004 Billy
1002 Hayley
1000 Jane
1001 Michael
1003 Peter






